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Downregulation of p-ERK1/2 and p-AKT expression by
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Background: Curcumin (CUR) and tetrahydrocurcumin (THC) inhibits tumor angiogenesis. It is suggested that
tumor progress may be related to the pathway of extracellular signal-regulated kinase 1/2 (ERK1/2) and serine/
threonine kinase AKT, but the mechanism remains unclear.
Objective: Investigate the effects of CUR and THC on the expression of ERK1/2 and AKT in hepatocellular
carcinoma (HepG2)-induced tumors in nude mice.
Methods: The curcuminoid mixture was obtained from the rhizomes of Curcuma longa, which was subjected to
silica gel column chromatography to afford CUR as the major constituent. THC was prepared by hydrogenation
of curcumin with palladium on charcoal as a catalyst. HepG2-implanted nude mice model was used to study of
angiogenesis and tumor progression. Expressions of phospho-ERK1/2 (p-ERK1/2) and phopho-AKT (p-AKT) in
HepG2-implated tissue were measured by immunohistochemistry. Tumor area, area of expression and expression
ratio of pERK1/2 and p-AKT were determined.
Results: Increases in p-ERK1/2 and p-AKT expression in HepG2 group was related to changes in tumor growth
in control, CUR, and THC groups. THC-treatment could attenuate the p-ERK1/2, p-AKT expression, tumor area,
and ratio of expression in HepG2-implanted nude mice significantly, compared to CUR-treatment.
Conclusion: HepG2-induced tumor progression may be inhibited by THC in part through the inhibition of
mitogen-activated protein kinase (MEK)/ERK and phosphoinositide 3-kinase (PI3K)/AKT.
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Hepatocellular carcinoma (HCC) develops with
neovascularization in tumors. Many molecular
signaling molecules may be involved in the regulation
of tumor development and angiogenesis. Recent
studies have shown that tumor development and
angiogenesis may be related with the pathway of
extracellular signal-regulated kinase 1/2 (ERK1/2) and
serine/threonine kinase AKT [1]. The ERK pathway
is a cascade of mitogen-activated protein kinase,

which is activated by vascular endothelial growth
factor (VEGF) [2]. Activated-ERK1/2 mediates
many cellular fates including growth, proliferation,
and survival. The AKT pathway plays a vital role in
cell proliferation, differentiation, and survival [3].
According to Schmitz et al. [4], increase in phospho-
ERK1/2 (pERK1/2) and AKT expression in HCC
indicates aggressive tumor behavior. Therefore, an
appropriate target for cancer therapeutics is to explore
drugs that inhibit or down-regulate the ERK and AKT
pathways.

Hepatocellular carcinoma (HepG2)-implanted
nude mice are an animal model for in vivo studies of
tumor development and angiogenesis. In a previous
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study [5], we directly observed capillary network
on the surface of tumors induced by HepG2 in a
dorsal skin chamber of nude mice, using intravital
fluorescence video-microscopy. The capillary density
measured increased significantly during tumor
development 7, 14, and 21 days after HepG2
implantation. In addition, the capillary density was
reduced by supplementation of curcumin (CUR) or
tetrahydrocurcumin (THC) [6]. This indicated that
CUR and THC might be potent inhibitors of tumor
angiogenesis because of their anti-oxidant activities.

It is reasonable to assume that the ERK and AKT
pathways might play an essential role in dynamical
process of tumor progress under supplementation
of CUR and THC. However, no data are available
for change in the expression of ERK1/2 and AKT
during tumor development. In this study, we
investigated effects of CUR and THC on ERK1/2
and AKT expression in HepG2-implanted nude mice.
Based on image analysis of immunohistochemical
stained tumor sections, we evaluated ERK1/2 and
AKT expression 7, 14, and 21 days after HepG2
implantation.

Materials and methods
CUR and THC preparation

The curcuminoid mixture was obtained from
the rhizomes of Curcuma longa , which was
subjected to silica gel column chromatography,
using hexane-dichloromethane, dichloromethane,
and dichloromethane-methanol as eluents to afford
CUR as the major constituent. THC was synthesized
from CUR by catalytic hydrogenation reaction, with
palladium on charcoal as a catalyst. The product was
purified by silica gel column chromatography followed
by recrystallization with dichloromethane-hexane to
give 75% yield of THC [7].

HepG2-implanted nude mice
Forty BALB/c-nude mice (male, 20-25 g) from

National Laboratory Animal Center of Salaya Campus,
Mahidol University, Thailand were used for this
study. The nude mice were bred and maintained in a
specific pathogen germ-free environment. The animal
experiment was conducted according to the guideline
of experimental animals by the National Research
Council of Thailand.

The nude mice were divided into four groups:
1) Controls supplemented with dimethyl sulfoxide
(DMSO (Con; n=10),

2) HepG2-implanted mice supplemented with DMSO
(HepG2+DMSO; n=10),
3) HepG2-implanted mice supplemented with CUR
(HepG2+CUR, n=10),
4) HepG2-implanted mice supplemented with THC
(HepG2+THC, n=10).

According to the procedure reported previously
[5], we prepared 30 HepG2-implanted nude mice.
Briefly, after anesthesia with sodium pentobarbital (50
mg/100 g body weight, i.p.), we implanted a dorsal
skin-fold chamber (7 mm in diameter) into the upper
layer of skin in a mouse. We inoculated 30 mL HepG2
cells (American Type Culture Collection, 2�106 cells,
viability 95-97%) into the middle area of the chamber.
Then, the mice were housed at one animal per cage,
where sterile water and standard laboratory chow were
freely accessed.

For the HepG2+CUR or HepG2+THC groups, the
mice were daily supplemented with CUR or THC
(2 mL of 3,000 mg/kg body weight) dissolved in 0.1%
DMSO. The supplement was started 24 hours after
inoculation of HeG2 cells.

Tissue sections for histolopgical examination
Parts of tissue within a dorsal skin chamber were

isolated from mice 7, 14, and 21 days after HepG2
implantation. The isolated tissue was fixed in 10%
buffered neutral formalin solution, and embedded in
paraffin wax. The solid sections were cut at 5 μm,
deparaffinized in xylene, and hydrated using graded
series of alcohol.

For each section with 5 μm thickness, endogenous
peroxidase activity was blocked with 3% hydrogen
peroxide for 15 minutes at room temperature. After
washing in water, non-specific binding sites were
blocked with 1% bovine serum in phosphate buffer
solution (PBS) for 30 minutes at room temperature.
Then, the section was incubated overnight at 4ΟC with
specific primary antibody for phospho-AKT (p-AKT)
(1:100 dilution), or phospho-ERK1/2 (p-ERK1/2)
(1:200 dilution) (Cell Signaling Tech, Beverly, USA).

The section was washed with PBS for five
minutes, and incubated with diluted biotinylated
secondary antibodies (1:200, Vector Laboratories,
Burlingame, USA) for 30 minutes at room temperature.
The specificity of the p-AKT or p-ERK1/2 antibodies
was confirmed in incubation without the p-AKT or
p-ERK1/2 antibody, respectively.

The stained sections were developed with 0.03%
diaminiobenzidine (DAB) as substrate, in a dark room
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for 10 minutes, counter-stained with hematoxylin
followed by dehydration, mounted under coverslips
with permount, and dried adequately.

Image analysis
The stained sections were used for image analysis

under a light microscope at magnification 10x. Using
ImageJ 1.38 software (National Institutes of Health,
USA), we calculated areas of tumors, activated
p-ERK1/2 and p-AKT expression according to the
procedure shown in Figure 1. These are 1) Convert
color image (A) of sample to grayscale 8-bit images
(B), 2) Set measurement scale by draw a line over a
100 μm section of the ruler, then Analyze → Set Scale,
3) threshold of grayscale image was adjusted by

manual settings by Menu Image → Adjust →
Threshold and outing of analyzed area will be draw
(C), 4) Calculate the analyzed area by Menu Analyze
→ Analyze particles, then outline of entire area is
automatically draw (D) and give a total area of each
image (E).

One section with 5 μm thickness included several
masses of tumors (see Figure 1(A). The total areas
of tumors, p-ERK1/2 expression, and p-AKT
expression on one section were calculated, and the
mean area of tumor (S, mm2), p-ERK1/2 expression
(SERK, mm2), and p-AKT expression (SAKT, mm2)
averaged over 20-sections of tissues were determined
as follows:

Figure 1. Schematic representation of the image analysis used to characterize the activated ERK1/2 and p-AKT expression
area. (10x, Bar=100 μm.).
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where N is number of slides used for image analysis.
In the present analysis, 20 slide samples (N=20) were
randomly selected in each mouse.

Percent area of SERK and SAKT were determined
using Eq (1) and (2), and Eq (1) and (3), respectively,
as follows:

Statistical analysis
All data are presented as means ± standard error

of mean (SEM). The data were analyzed by pair
t-test and one-way ANOVA followed by the LSD
test for comparisons of all pairs of groups. A p-value
less than 0.05 was considered significant. All analyses
were performed using SPSS version 13.0 (SPSS Inc,
Chicago, USA).

Results
Figure 2 shows microscopic images of

immunohistochemical stained sections for four groups
(one control, three HepG2). HepG2 tumor sections
exhibited p-ERK1/2 and p-AKT expression, while
normal tissue exhibited no staining. The p-ERK1/2
and p-AKT expression revealed a specific positive
nuclei immunostaining. Note that p-ERK1/2
and p-AKT expression were most marked in
HepG2+DMSO group. CUR or THC supplementation
reduced the over-expression of p-ERK1/2 and
p-AKT.

Tumor area
Figure 3 shows the tumor area calculated by

Eq. (1) for three HepG2 groups 7, 14, and 21 days
after HepG2 implantation. We note that the tumor
area increased with days after HepG2 implantation,
and CUR or THC supplementation reduced the
growth of tumor area.

Figure 4 shows the mean areas of ERK1/2 and
AKT expression (SERK and SAKT, mean±SEM) of each
group calculated by Eq (2) and (3) on days 7, 14, and
21 after supplementation of DMSO, CUR or THC in
HepG2 groups. The SERK and SAKT have gradually
increased from 7 to 21 day.

Figure 5 shows percent expression ratios of
ERK1/2 and AKT (%SERK and %SAKT, mean±SEM)
of each group calculated by Eq (4) and (5) on days 7,
14, and 21 after supplementation of DMSO, CUR,
or THC in HepG2 groups. The %SERK and %SAKT
significantly increased in HepG2 group, but they were
attenuated by both high dose treatments with CUR
and THC. Interestingly, THC treatment shows a
significant attenuate area of p-ERK1/2 and p-AKT
expression than CUR, suggesting that THC has more
potential than CUR on suppression of activated ERK1/
2 and AKT.

Discussion
In this study, we investigated the expression of p-

ERK1/2 and p-AKT to assess the effectiveness of
CUR and THC in HepG-induced tumors in nude
mice. We assumed that p-ERK1/2 and p-AKT were
expressed in tumor cell nuclei on immunohistochemical
stained sections. By counting number of positively
stained pixels, we measured the areas of tumors,
p-ERK1/2 expression, and p-AKT expression over
20 images per each mouse and 200 images per each
group.

In the present experiment, increases in p-ERK1/
2 and p-AKT expression might be closely related with
and changes in tumor growth in control, CUR, and
THC groups, as shown in Figures 3 and 5. This result
agrees with previous reports [4, 8-9] showing that
increased pERK1/2 and AKT expression was
associated with aggressive tumor behaviors in
hepatocellular carcinoma. According to recent studies
by Jiang et al. [3, 10], PI3K, and AKT play a key role
in regulating tumor growth and angiogenesis through

% SERK = SERK/S (x100%),                     (4)
% SERK = SERK/S (x100%).                     (5)

                                          N
S = (1/N) ∑ i (total area of tumor in each section),                             (1)

          i=1

           N
SERK  = (1/N) ∑ i (total area of tumor in each section),             (2)

           i=1

           N
SAKT  = (1/N) ∑ i (total area of ERK1/2 expression in each section),         (3)

        i=1
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VEGF and HIF-1 expression, while the MEK/ERK
signaling pathway induces NF- κB activation to
regulate angiogenesis. Therefore, our task is to develop
drugs that inhibit or down-regulate the ERK and AKT
pathway for cancer therapy.

The present results demonstrated that THC could
inhibit p-ERK1/2 and p-AKT expression, and
expression ratio (Figures 4 and 5), which may be
associated with the tumor area (Figure 3). In previous
study [11], we showed that CUR could inhibit

several angiogenic biomarkers such as VEGF and
cyclooxygenase-2 (COX-2) expression. Recently,
Roskoski et al. [2] and Namkoong et al. [12] showed
that VEGF stimulating pathway is dependent upon
activating the MAP kinase/ERK and PI3K/AKT
pathway. Since MAP kinase/ERK and PI-3/AKT
pathways influence COX-2 stimulating pathway [13],
they should be involved in the mechanism for CUR to
inhibit tumor angiogenesis and tumor progression.
Although CUR is an important anti-cancer and anti-

Figure 2. Immunohistochemical-stained images showing p-ERK1/2and p-AKT expressions in control group,
HepG2+DMSO, HepG2+CUR and HepG2+THC group on day 21. (10x, Bar=100 μm.).
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angiogenic agent, the molecular mechanism of CUR
activities remains unclear. Sharma et al. [14] made
clinical studies of oral CUR (phase I) and revealed
that low systemic bioavailability followed oral dosing.
This reason might be that the ultimate metabolites of
CUR were not used. In fact, substantial beneficial
effects could be achieved with lower levels of these
active metabolites compared to the parent compounds.

THC is a reduced analog of CUR with phenolic
and β-diketo moieties as well as CUR. THC is
valued as the ultimate metabolites of CUR in vivo.
According to Sugiyama et al. [15], the β-diketone
moiety may play an important role in the elucidation
of anti-mutagenesis or anti-carcinogenesis. In addition,
β-diketone type antioxidants such as n-tritriacontan-

16,18-dione (TTAD) have been reported to inhibit
tumor promotion and carcinogenesis [16]. THC may
be more effective than CUR in vivo because THC is
more easily absorbed and resistant to hydrolysis than
CUR from gastrointestinal tract [17].

In conclusion, THC markedly decreased the
MEK/ERK and PI3K/AKT expression associated
with its inhibition of HepG2-induced tumor in nude
mice model. Our data provide a potential role for THC
in the pathogenesis of tumor progression.
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Figure 3. Tumor area (mean±SEM) of HepG2, HepG2+CUR, HepG2+THC groups on days 14 and 21 after
supplementation of DMSO, CUR or THC. *p <0.001 vs. HepG2 with vehicle on day 7, ap <0.001 vs.
HepG2+CUR on day 7,  %P <0.05 vs. HepG2 with vehicle on day 7,♦p <0.001 vs. HepG2 with vehicle on day 7,
♦♦p <0.001 vs. HepG2 with vehicle on day 14, +p <0.01 vs. HepG2 with vehicle on day 14, ++p <0.001 vs. HepG2
with vehicle on day 14, bp <0.05 vs. HepG2+CUR on day 14, Δp <0.001 vs. HepG2+DMSO on day 21, cp <0.01
vs. HepG2+CUR on day 21.
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Figure 4. Area of ERK1/2 and AKT expression (mean±SEM) of HepG2, HepG2+CUR, HepG2+THC groups on days 7, 14,
and 21 after supplementation of DMSO, CUR, or THC. *p <0.001 vs. HepG2 with vehicle on day 7, aP <0.05 vs.
HepG2+CUR on day 7,  %P <0.005 vs. HepG2 with vehicle on day 7,  % %p <0.001 vs. HepG2 with vehicle on day
7, f&p <0.005 vs. HepG2 with vehicle on day 14, +P <0.001 vs. HepG2 with vehicle on day 14, bp <0.05 vs.
HepG2+CUR on day 14, cp <0.005 vs. HepG2+CUR on day 14, Δ p <0.001 vs. HepG2 with vehicle on day 21,
dp <0.05 vs. HepG2+CUR on day 21, ep <0.005 vs. HepG2+CUR on day 21.

Figure 5. Expression ratio (mean±SEM) of ERK1/2 and AKT in HepG2, HepG2+CUR, HepG2+THC groups on days 7, 14,
and 21 after supplementation of DMSO, CUR or THC. *P <0.001 vs. HepG2 with vehicle on day 7, ap <0.05 vs.
HepG2+CUR on day 7, +p <0.001 vs. HepG2 with vehicle on day 14, bp <0.005 vs. HepG2+CUR on day 14,
cp <0.001 vs. HepG2+CUR on day 14, Δp <0.001 vs. HepG2 with vehicle on day 21, dp <0.005 vs. HepG2+CUR on
day 21, ep <0.001 vs. HepG2+CUR on day 21.
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